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Chapter 2: Fooling around with Photoshop

Selection Tricks

What is so hard about selection? You may ask. Isn’t selection just selecting an
image or a portion of an image? So what'’s there to learn?

Here’s my question to you then: Are you able to make near-perfect selection? If
you think you can, you are given the privilege to skip this chapter.

Let's see... What do we need? There are two different methods to go about
selection: the Extract way and the Manual way. First up, the manual way. This is
definitely my preferred choice of all times.

Here is the list:

X' Magnetic Lasso

X' History Brush

X' Adjustment Layer (Levels, Contrast)
X' And... The Spacebar

A Quick Revision...
X' What is the Magnetic Lasso

o The magnetic lasso tool (Photoshop), the border snaps to the
edges of defined areas in the image and it is especially useful for
quickly selecting objects with complex edges set against high-
contrast backgrounds. Using it is relatively simple. Just define a
starting point by clicking on the border of the portion of image that
you will like to select out of the original image.

X' History Brush

o There will always be some imperfect parts of our selection and
copy. The history brush can be used to return the missing bits that
we did not select properly with the magnetic lasso.

One thing to take note will be that the history brush can only return
image to the origin (meaning the original image without any
alterations), if you wish to select portion of image out of a image
that you have altered, save the altered image as a jpeg, then close
it and reopen it to begin the selection process.
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X' Adjustment Layer (Levels, Contrast)

o There may be image that is too dark or without clearly defined
edges for selection. Add an adjustment layer and you can tone up
the contrast and brightness by using adjustment layer, which have
relatively no effects on your image. Discard it after you're done.

X' The Spacebar

o0 This helps to pause any process for re-navigation, sometimes we
need to zoom the image to a much bigger size than 100%, and our
portion for selection may go out of screen size scope, so while
select, we’ll need to navigate. The spacebar is just the tool for it.
Press Ctrl+ to zoom in, Ctrl- to zoom out.

Lets’ get down to selection now!
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Example: Totoro wants out!!

The scene is set. It is a night scene whereby Totoro, May and her little sister are
waiting for bus at a dimly lit bus stop. Totoro is ready for a “little” exercise of
popping out of the image, how can we let Totoro pop out if he is part of the image?
We need to get Totoro onto a new layer. Here we go!
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We have to address some problems before we can embark on our mission.

I£ Adobe Photoshop - [1066934804. jpg @ 300% (RGB)]
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The whiskies of our darling Totoro practically ‘blends’ into the background, it will
be hard to make a proper magnetic lasso selection. Another point that we have to
be conscious of will be that the umbrella end is barely visible and definitely not
i clearly defined enough for magnetic
lasso selection. So what is there for
us to do? Is it then impossible for us
to fulfill Totoro’s dream of popping
out of the image?
Believe in this: Nothing is impossible
in Photoshop when it comes to
image creation and  editing.

Remember that | mentioned Adjustment Layers?

We'll add a Levels Adjustment Layer.
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Layers > New Adjustment Layer > Levels

| Ok,

[l Group With Previous Layer

Color: | [ ] Mone :}
IMode: | Mormal v | Opacity: [100 # | %
Just Click Ok.
Channel: | RGB v| o
Input Levels: {100 [[255 | [ Reset |
| Load. |
[ Save. |
| Auto |
= = > | | Options... |
Output Levels: IIII ||255 | FAV AP
| !
o 2 [V Preview

You will get this dialog box. Play with the sliders to increase brightness/contrast
of the image. Ultimately, your motive is to increase the brightness to help you
with the selection.

Here are my settings: Input Levels: 20, 1.4, and 125
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I£ Adobe Photoshop - [1066934B04. jpg @ 300% {Levels 1, Layer Mask)]
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Ok, the image looks too bright. But we have achieved our motive of brightening it
so the whiskies and the umbrella end can get a better ‘definition’ of edge and
contrast in order for magnetic lasso to work.

Select the magnetic lasso tool and start the selection by clicking on any point of
the image portion that you will like to select, any point will do.

Press the spacebar and hold down whenever you need a little clicking rest or
whenever you need to re-navigate since you have zoomed in to the image for
better selection. After you are done with going round the edge of Totoro, click on
the start point of your magnetic lasso to close the selection.

However, the magnetic lasso will only allow border selection. How can we
remove the spaces in between Totoro’s ears and underneath the umbrella then?

Recall from Chapter 1, how can we minus away selection? After you have
finalized the selection, meaning you have closed the magnetic lasso path, hold
down Alt key and using the magnetic lasso tool, select the parts to minus away.

Alternatively, you can do this after you have copied Totoro onto a new layer, then
you will use the magnetic lasso tool to select parts to remove and just press
delete.
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Check that you are on the background layer with Totoro and not the adjustment
layer. Click on the background layer if you're not. Don’t worry; you will not lose
your selection just by switching layers in the layers palette. Press Ctrl-J, this is
for you to put whatever that is in the selection onto a new layer.

If there are any imperfect areas/edges, do not bother to redo the selection. Select
the History brush from your toolbox and brush through those portions that are
imperfect. Use the eraser to erase away any excess areas as well.

You are done.

I reduced the master opacity of the background layer to show the Totoro that I've
managed to cut and placed into a new layer.
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I'll show you all a nice photography trick here.

How does this looks?

Totoro has succeeded in popping out of the image. You can try this effect for
real-life photos also.

Examples:
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Here’s the trick exclusively for readers of this whole web course.

iéf m

Taking the rectangular marquee tool, make a rectangular selection.

Duplicate the background layer twice and delete away the background layer, you
should have background layer copy, background layer copy2. Background copy
will be on top of background copy?2.
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Ensure that you are on the background copy layer. Press Delete

Drop Shadow Stroke
Structure Structure

Elend Mode: | Multiphy | Size: p———— 1o P
Cpacity: ———— 2 |75 !% Position: m vi

Cpacity: ——[100 | %
Distance: Cr————— |10 ipx

Fill Type: | Col v
Sp[ead:;l i} ]% AR =er
Size: @ 11| pr 'CD|DF2|:|
Guality
Contour: i Dﬁ.nti—al_iased

Moize: am——---I" ]%

La:.rer Knocks Qut Drop Shadow

Click on the “f” icon on your layers palette and apply these two layer styles
effects to the background copy layer to obtain the polariod picture effect for the
trick.
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There’s a lot more to layer styles. Play around and experiment yourself whenever you want to.
There are unlimited variations.
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Drag the drop shadow effect from the background copy to the layer with Totoro.
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= 12104790 P Draw selection from center or subtract from existing selection.

Totoro doesn’t look that popping out of the image, does he or it? He/lt has a drop
shadow on top of the Polaroid background which tends to give the feeling that
Totoro is a ‘cut n paste’ product and not part of the original background, it defeats
the original purpose of making Totoro pop out.

We’'ll correct that.

Under the Totoro layer, there will be an area which lists out the effects used in
this very layer, right click on the word "effect" and select "Create Layer”. Click ok.

Ctrl-Click on the background copy layer to bring up the rectangular marquee of
the background copy.
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Ensure that you are on the Totoro’s Drop Shadow layer. Press delete.
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Now it looks like Totoro has indeed popped out of the image.

If you want a proper bus stand, go back to background copy 2 layer and make a
small rectangular marquee just enough to hold the bus stand base.

Right click within the marquee and select transform selection. Rotate the
selection to a nice angle.

Ctrl J. Move this new layer on top of the background copy layer. Remember the
previous lesson on layers? Layers interact on top-down sequence.

Repeat the stroke and drop shadow effects to get the Polaroid effect or
alternatively, you can drag the entire effect from the background copy layer to
this layer/right click copy layer style and at this new layer, right click paste layer
style.
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You can use the Extract Tool to extract portions of any image as well, the only
criticism that | have about this tool will be the fact that some selections made are
not perfect and we are not in full control for the extraction of images. In the case
of the Totoro, | doubt that it will work well. Marquees and the above method may
need a lot of practice but they work well and produce 100% satisfactory results.
As the saying goes "No pain, no gain.”

Here’s the Extract way for show:

Step 1:

Select an
image.

Step 2: Step 4: Using the airbrush
Filter > Extract and eraser, paint/erase
areas with blemishes.
Using the
highlighter, go
about the
outline of the
portion that you
want to extract.

Step 3:

Using the paint
bucket tool in
Extract, fill your

selection.
Step 5:

Click Ok. Add a background for your
image or move it to another
image.

> 98 =2
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Here is another exclusive trick with the Extract tool for you: Rugged framing
borders!

Filter > Extract

|£2 | Use the Highlighter tool to cover the edges of areas to be retained. Try Smart Highlighting on well-defined edges. i
Reset
Praview

— Tool Options
Brush Size: is »
Highlight: | Green v
Fil: Blue |

[] smart Highlighting

Extraction
Smaoth: 100 3
channel: fone

I:‘ Force Fareground

— Preview

Display: ; Mone G|

e S ||

Shew Highlight

Shaw Fill

The Highlighter is for you to highlight the edges for selection. Increase brush size
to about size 30. Paint Bucket is for you to finalise selection. Eraser is also used
to create blemishes in the framing to achieve the rugged border effects.
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Click Prewview to sea the image with the background rermoved or OK to extract and exit immediateby.
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Here’s what | did.

Using the highlighter, | made a frame selection around.
Using the eraser, | erased parts of the frame.

Fill with the paint bucket to finalise the selection. Press Ok.
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That's it. This effect is cool for metallic creations.
The section on Selection Tricks with ends here. It is hoped that you have learn

something out of this chapter, on how to select image accurately.

Next, we will be moving on to Let’'s Merge! where we will be touching on how to
fake images, merging images to create fakingly real compositions that shocks.
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